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Preface

Welcome to Oracle Support, Release 11i.

This Concepts and Procedures guide provides information and instructions to help 
you work effectively with Oracle Support.

This preface explains how this Concepts and Procedures guide is organized and 
introduces other sources of information that can help you.

Intended Audience
This guide is aimed at the following users:

� Technical Service Representatives (TSR)

� Customer Service Representatives (CSR)

� System Administrators (SA), Database Administrators (DBA), and others with 
similar responsibility.

This guide assumes you have the following pre-requisites:

1. Understanding of the company business processes.

2. Knowledge of products and services as defined by your marketing policies.
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Structure
This manual contains the following chapters:

“Understanding Service Request" provides overviews of the application and its 
components, explanations of key concepts, features, and functions, as well as the 
application’s relationships to other Oracle or third-party applications.

“Using Service Request” provides process-oriented, task-based procedures for using 
the application to perform essential business tasks. 

“Understanding DMS" provides overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle or third-party applications.

“Using DMS” provides process-oriented, task-based procedures for using the 
application to perform essential business tasks. 

Related Documents
For more information, see the following manuals:

� Oracle Service Implementation Guide

� Oracle Service Concepts and Procedures Guide

� Oracle Customer Care Implementation Guide

� Oracle Customer Care Concepts and Procedures Guide

� Oracle Support Implementation Guide
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Understanding Service Requests

This topic group provides overviews of the application and its components, explanations of 
key concepts, features, and functions, as well as the application’s relationships to other 
Oracle or third-party applications. 

n Overview of the Service Request Module

n Integration with Other Products

n Features

n Service Request Business Process

Overview of the Service Request Module
Customers contact your support department via phone, e-mail, or web when they experience 
difficulties using or understanding the product, or with the functioning of the product. In 
response, a support agent initiates a service request, or if there is a self service support 
application, the customer logs a service request himself. 

The Service Request module allows an organization to manage customer requests for service 
assistance. A service request is a report of a specific problem that requires support assistance 
to resolve. The Service Request module is integrated with a powerful Knowledge 
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Integration with Other Oracle Products
Management module so that you can leverage existing knowledge within the organization 
and build your solutions knowledge base by channeling information you collect while 
responding to service requests.

The Service Request module categorizes each customer request for service into 
user-definable service request types such as product complaints, field failures, and product 
inquiries. Service requests are not limited to functioning customer products, since you can 
log requests for non-product issues such as clarification of documentation, resolution of 
implementation issues, and product upgrade information.

While logging service requests, you can assign an urgency and severity status for each 
request. An urgency reflects the service request from the contact’s view of the event, while 
the severity reflects the service person’s interpretation of the issue. Setting these attributes 
allows a timely resolution for each service request.

In the service request setup forms, you can fully define your service requests by Type, 
Status, Urgency, Severity, Problem, and Resolution codes. Each code serves to refine the 
service request definition and aids in problem trend analysis and resolution.

Integration with Other Oracle Products

Installed Base
A service request describes all the necessary information about the customer problem to 
determine the best plan of action to resolve the issue effectively. The Installed Base module 
stores information about the customer, customer site, and the installed customer product. 
With a direct link to Installed Base, you can verify customer and product information. You 
can verify the current service coverage for a customer product or system. If the customer is 
unknown to the installed base, then you can add him to the installed base.

Call Center
If your customer service center handles a large volume of telephone calls, you can automate 
your call center by leveraging the integration with computer telephony software. Based on 
call characteristics, you can intelligently direct the call to an appropriate agent, who can 
access information entered by the customer before picking up the phone.

Knowledge Management
More than eighty percent of the requests for assistance from customers coming to a customer 
service center involve issues and problems that have already been resolved. The Service 
Request module leverages a knowledge base of structured solutions sets of information. As 
new service requests are logged, service personnel may search this knowledge base to 
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Integration with Other Oracle Products
identify solutions that have worked in the past. They can then provide a solution to the 
customer while logging the new service request. Service personnel may also build new 
solution sets during the resolution process.

Workflow
Once they are logged, you can route the service requests, based on Type, to service 
personnel in your organization and move them through a workflow-based resolution process 
tailored to your own unique business requirements. Using Oracle Workflow, you can 
implement procedures that automatically notify service personnel about their assignments.

You can define business rules to identify service requests that violate your service standards 
or response guidelines, and then automatically take corrective actions to the appropriate 
person.

Service requests can have an unlimited number of tasks to represent what has been done or 
has been scheduled to be done to resolve the service request. For each task, you can specify 
an owner, assignees, a status, a user-defined task type, start and end dates and times, and 
free-form text describing the task. Additionally, you can use task status as a parameter to 
route tasks through a separate workflow-based resolution process analogous to the workflow 
process used for service requests.

Quality
You can set up collection plans in Oracle Quality that capture relevant data as service 
requests are logged by customer service personnel. Collection plans may capture data related 
to a customer, product, product line, etc. You can then analyze this data in Oracle Quality to 
answer queries such as the most common problems faced by users, or products that cause the 
most problems. You can also export the captured data to other tools to perform detailed 
statistical analyses.

Charges
Using the Charges capability, a service organization can bill customers for services provided 
in response to support service requests, field service request or depot repairs. Charges also 
provide the functionality of creating a Return Material Authorization (RMA) to return a 
defective product for repair, loaner or replacement which allows you to manage customer 
expectations while controlling inventory receipts and customer credit processing.

Defect Management System
The integration of the Service Request module with the Defect Management System allows 
you to create a defect from a service request. You can automatically link the service request 
to the defect for tracking purposes.
                                                                Understanding Service Requests 1-3



Features
Features
The Service Request module helps you to manage customer requests for service in the 
following ways:

n Confirm customer and product information; name, number, product, system, or serial 
number.

n Define the customer’s request for service.

n Define service request status, types, severities, and urgency.

n Verify service contract entitlements automatically.

n Assign problem and resolution codes to each service request.

n Link service requests and defects.

n Search a knowledge base to resolve and expedite service requests.

n Contribute to knowledge base.

n View interaction history.

n Saved knowledge base solutions in a service request.

n Build new solutions during the resolution process.

n Create multiple tasks for a service request.

n Assign the right resource to perform the task.

n Provide an audit trail of service request changes.

n Send the service request report by email or fax.

n Create a defect.

n Escalate a service request.

n Update counters.

n Automate business processes used during service request resolution.

n Collect quality control information linked to service requests.

Service Requests Business Process
The Service Request module functions as the central reaction point for a customer support 
agent who needs to respond to a customer request. An interaction between customer and 
support agent results in either an immediate resolution of the problem or a work assignment 
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Service Requests Business Process
to qualified individuals. The customer support agent uses several application functions to 
facilitate a response to a customer problem.

A typical scenario for a customer calling for assistance is given below:

The overall process that facilitates the solution to a customer problem varies with each 
instance, but the process always involves a service request.

Step Description

1 A support agent accepts a customer call from the Universal Work Queue.

2 The agent identifies the customer using the Contact Center. The agent views the customer 
profile. The agent can update the customer information.

3 Agent verifies entitlement and logs a new service request in the Contact Center.

4 Agent searches the knowledge base for solutions to customer problem. Optionally, the 
agent contributes to the knowledge base while solving the problem. 

5 Optionally, agent creates a task and assigns the work according to configured business 
rules.

6 Agent views the interaction history from service requests for the customer.

7 Agents views the service request log to understand the progress toward resolution.

8 Optionally, the agent links the service request to another service request.

9 Optionally, the agent assigns the service request to another agent and launches the 
appropriate workflow.

10 Agent may create a charge line to return a defective product or bill the customer for the 
services provided.

11 If the product is defective, or if it requires an enhancement, the agent logs a defect report.

12 The agent escalates the service request and assigns the escalation to an account manager.

13 The customer demands a copy of the service request. The agents sends a fulfillment 
request containing the history of the service request to the customer.

14 Optionally, the agent completes a collection plan to capture quality information used to 
improve business processes.
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Using Service Request

This topic group provides process-oriented, task-based procedures for using the Service 
Request module to perform essential business tasks.

n The Service Request Window

n Creating a Service Request

n Verifying Product Coverage Information

n Searching the Knowledge Base from a Service Request

n Contributing to Knowledge Base from a Service Request

n Creating Viewing and Updating Tasks from a Service Request

n Creating and Viewing Notes in Service Request

n Viewing Customer Interactions

n Managing Service Request Contacts

n Managing Customer Addresses

n Viewing Service Request Log

n Linking Related Documents to a Service Request

n Finding a Service Request

The Service Requests Window
The Service Request module is the central reaction point for a customer support agent who 
needs to respond to a customer request. Normally, the support agent will use the Service 
Requests window to create and manage service requests.
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The Service Requests Window
To access the Service Requests window:
1. Log on to Oracle Applications.

2. Choose Customer Support Responsibility. 

The Customer Support Navigator window appears.

3. Use the following path to open the Service Requests window:

Service Request—>Create Service Request

The Service Request window comprises eight tabs. Each tab allows access to a function that 
contributes to the process of managing a service request. The support agent can manage 
customer information, problem details, problem resolution, service history, and task 
assignment to assist and sustain a support center.
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The Service Requests Window
The following table explains the functions supported by each tab in the Service Request 
window.

Additional functionality related to service requests such as entering charges, creating a 
defect, viewing audit history, sending a fulfillment request, and viewing audit history can be 
accessed from the Tools menu of the service request.

References:
n Buttons in the Service Request Window

n Accessing Caller Information

n Viewing Customer Profile

Tab Name Function of the Tab

Product Coverage View and edit product attributes.

View and select the contract entitlements.

Workbench Enter problem description and notes of various types.

Search the knowledge base.

View respond by and enter expected resolution dates.

Log View the history of various events in the lifecycle of a service 
request.

Contacts View and edit customer contact information.

Addresses View and edit customer billing, shipping, and installation address 
information.

Tasks View or assign tasks associated with a service request.

Interactions View the customer interaction history.

Related Documents View or link related service requests and defects associated with a 
service request.
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Buttons in the Service Requests Window
Buttons in the Service Requests Window
The following four buttons are available from the Service Requests window irrespective of 
the tab you are currently on.

Call Information:  Use this button to open the Call Information window where you can 
view call (IVR) parameters such as ANI, DNIS, Order, System, Account Code, Service 
Request Number, etc. which the customer enters while calling up for customer support.

Call Wrap Up:  Use this button to open the Call Wrap Up window where you can enter 
information about the outcome of the interaction with the customer as well as other call 
wrap up information.

End Interaction:   Use this button to terminate the customer interaction if you have no 
wrap up information to enter into the Call Wrap Up window. Pressing this button to end the 
present interaction signals that you are ready to accept new calls.

Agent On Break:  Use this button to signal that you are on a break and are not available to 
accept calls. The button label changes to Agent Off Break. When you are ready to accept 
new calls, press this button to signal that you are back from the break.

Accessing Caller Information
You may view caller details by searching for it or by using the List of Values available in the 
Service Requests window. For detailed procedures on searching for customer information, 
see Finding a Service Request.

To access caller information:
1. Choose a caller type in the Caller Type field in the Service Requests window.

2. Select the caller type for which you want to create the service request. You can create a 
service request for an organization, person or employee. The fields displayed in the 
Service Requests window changes based on the caller type you select. 

3. Select the parameters based on which customer data is to be displayed. 

a. If your caller type is Organization (used in Business to Business service):

* Select the company for which you want to create the service request. 

* Select the first and last name of the support contact at the selected company.

b. If your caller type is Person (used n Business to Consumer service) or Employee, 
select first and last name. 
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Viewing Customer Profile
The Service Request module populates the Service Requests window with the customer 
data logged in the Contact Center.

Based on the customer location, the time zone field shows the time zone of the customer 
and also shows the time lag between the customer and the agent.

References:
n The Service Request Window

n Buttons in the Service Request Window

n Viewing Customer Profile

Viewing Customer Profile
Customer Profile information summarizes customer information and indicates if a customer 
is critical, thereby helping you make intelligent decisions while providing customer support. 
The profile entries appearing in the customer profile are typically set up by a system 
administrator, and contain a set of predefined checks. These checks and the actual value 
range and value definitions can be configured. The check results are displayed by utilizing 
the Customer Profile Engine, which is a concurrent program.

Customer profiles need to be defined for a customer before they can be viewed in a service 
request. For information on creating customer profiles, please see the Oracle Customer Care 
Implementation Guide.

To view customer profile:
1. Navigate to the Service Requests window.

2. Create or query up a service request.

3. Click on the Profile button. The profile window, displaying the predefined profiles, 
opens. Customer profiles are defined by the System Administrator. 

Double-click on a key indicator to view a summary list of that profile check. For example, 
double-clicking on Open Service Request (a possible key indicator) displays the drill-down 
list showing all open service requests for the selected contact. This list displays information 
such as the service request number, creation date, etc. Double click on any line to view 
details of that service request. The Service Request window containing details of the service 
request opens. 

Click on the Refresh button to view the latest information for the customer.
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Creating a Service Request
References:
n The Service Request Window

n Buttons in the Service Request Window

n Accessing Caller Information

Creating a Service Request
The first step in solving a customer problem is creating a service request that captures all the 
problem details. In a typical scenario, customer information is validated using the contact 
center and then the support agent can open the service request window to log a customer 
request for assistance.

To create a service request:
1.  Navigate to the Service Requests window.

2. Access the appropriate information on the caller for whom you want to create a service 
request. See Accessing Caller Information for details.

The Service Requests window displays the customer data logged in the Contact Center.

Based on the customer location, the time zone field shows the time zone of the customer 
and also shows the time lag between the customer and the agent.

3. Select the Installed Base checkbox if the customer issue is about a customer product. If 
this checkbox is selected, the Product list of values will display only the products 
installed at the customer site, else it will show you all the inventory items. Note that 
System and Reference Number fields are enabled only when the Installed Base 
checkbox is selected.

4. Select a product and a serial number. The application displays information in the 
remaining fields based on your selection. The fields in Product Coverage tab are also 
updated to display appropriate product information. To view these details, click the 
Product Coverage tab.

5. The contracts area shows the various contracts for the customer. Double-click the 
contract number to view coverage information for a particular contract. Select the 
contract that will apply to this customer request.

6. Select values in the Type, Status, Severity, Owner and Owner Type fields, if they are 
different than the default values. Default values in these fields are governed by the 
profiles setup. For more information on profiles, see Setting Up Service Request 
Profiles in the Oracle Support Implementation Guide.
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Creating a Service Request
7. Click on the Workbench tab. Enter a brief description of the customer problem/request 
in the Request Summary field.

8. Select urgency, problem code and resolution code in the appropriate fields. Enter a 
helpdesk number, if supplied by the contact for their own tracking purposes.

9. The date in the Respond By field is defaulted based on the contract with the customer. 
Enter a Resolution By date if the contact provides an expected resolution date.

10. Save the service request.

The Service Request module assigns a service request number, which will be displayed 
in the Request field. Note this number for future reference to your service request.

Service Request Defaults
Service request default values, specified by user profiles, help you enter service requests 
quickly. You can set user profiles to default the following values as you enter service 
requests:

n  Type

n Status

n Owner

n Owner Type

n Severity

n Urgency

n Note Type

n Note Status

n Knowledge Base Solution Type

n Task Priority

n Task Status

n Task Type

n Task Owner

n Task Owner Type

n Task Assignee

n Task Assignee Type
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Verifying Product Coverage Information
You can override these defaults if necessary by changing the appropriate profile options. For 
more information, see Setting Service Request Profile Options in the Oracle Support 
Implementation Guide.

Verifying Product Coverage Information
The Product Coverage tab details the specific attributes about the product (inventory item or 
customer product) for which the service request is logged and provides information on the 
various contracts covering the customer. 

The product attributes and contracts information help you to:

n Confirm the product details with the customer.

n View contract details: While logging a service request, the agent can look up contracts 
associated with the customer/site/product to ensure that all contractual requirements like 
coverage times, response times, effective dates, billing rates and entitlements are met. 
An organization may or may not enforce contract validation.

Note that customer products, contracts and coverages must be defined before they can be 
viewed in a service request.

To verify product coverage information:
1.  Navigate to the Service Requests window. 

2. Access the appropriate information on the contact for whom you want to create a 
service request. See Accessing Caller Information for details.

Oracle Customer Support populates the Service Requests window with the customer 
data logged in the Contact Center.

Based on the customer location, the time zone field shows the time zone of the customer 
and also shows the time lag between the customer and the agent.

3. Select the Installed Base checkbox if the customer issue is about a customer product. If 
this checkbox is selected, the Product list of values will display only the products 
installed at the customer site, else it will show you all the inventory items. Note that 
System and Reference Number fields are enabled only when the Installed Base 
checkbox is selected.

4. Select either a product or a serial number. Alternatively, click the Find button to search 
the installed base for customer products. For more information on using the Search 
feature, see Finding a Service Request.
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Searching the Knowledge Base from a Service Request
The application displays information in the remaining fields based on your selection. 
The fields in Product Coverage tab are also updated to display appropriate product 
attribute and contract information. The contracts area shows the various contracts for 
the customer. 

5. Click the Get Contracts button. This will show all active contracts available based on 
the information entered in the service request. To view all contacts click the All 
Contracts button prior to clicking the Get Contracts button. Select a contact for service 
coverage by selecting the Selection checkbox.next to the desired contract row.

6. To view coverage information for a particular contract, double-click the contract 
number in the Contract area on the Product Coverage tab. The Service Contracts 
Coverage window opens.

n The Service Contracts Coverage window displays details like coverage name, 
description, type, business processes to which this is attached, preferred engineers 
as per contract, effective dates and any exception coverage.

n The Coverage Times tab shows service coverage hours by weekday.

n The Reaction Times tab displays reaction time according to severity of the problem.

n Billing Types tab shows the billing type, rate, and percentage coverage. For labor 
billing type, you can also view bill rate and percentage of discount if applicable on 
the rate.

7. Close the Service Contracts Coverage window to return to the Service Requests 
window.

Reference:
n Creating a Service Request

Searching the Knowledge Base from a Service Request
After logging a service request, you can search the knowledge base. The knowledge base is 
a repository of solution sets that have already been contributed.

The knowledge base search can be based on:

n Keywords 

n Similar statements

n Symptoms, Causes, Actions or other defined knowledge statement types 

n Solution sets
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Searching the Knowledge Base from a Service Request
Note that the knowledge base system must be properly set up for this feature to work. 

The knowledge base can be searched directly from the Navigator.

To search knowledge base:
1.  Navigate to the Service Requests window. 

2. Create a service request or open an existing one by running a query.

3. Click on Search Knowledge Base button on the Workbench tab. The Knowledge Base 
Search window opens.

Certain types of notes saved on the service request are defaulted on the search screen. 
Note types are setup from the Knowledge Management module. The contact name and 
the product fields are also defaulted from the service request. The Service Request 
summary is defaulted into the Keywords for searching.

4. Select the notes to be used as the search parameter by selecting the Selection checkbox. 

5. To search for similar statements, select the Search For drop-down list and click the 
Search button. The details of a note can be viewed by clicking the Details button next to 
the note.

6. On clicking the Search button, the search results appear in the table at the bottom of the 
search window. The details for a solution can be seen by clicking the Details button next 
to it. The Solution Detail window opens. This window displays solution details.

7. If you find a result useful to the customer and want to save it, select the checkbox next 
to the result and click the add button. This will add the result to the list in the top 
section.

Once a result is added to the top section of the search window, the save button becomes 
enabled.

8. Click the Save button to save the added results along with the service request. These 
results can be viewed in the spreadtable under the Notes and Knowledge Base 
Statements area on the Workbench tab.

Notes: You can run a keyword search by entering a keyword into the 
Keyword field and clicking the Search button. The Service Request 
summary is defaulted into this field. This can be modified prior to the 
search.

You can search for a solution set for a statement type by selecting from the 
Search For drop-down list and clicking the Search button.
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9. If you find that a particular solution has solved the customer problem, you may increase 
the score of the solution. To increase the score of a solution, open the Knowledge Base 
window and select a saved solution and then click on the Solved button.

10. To close the Knowledge Base search screen, click on the Exit button.

Contributing to Knowledge Base from a Service Request
The knowledge base search screen also allows a user to contribute to the knowledge base.

Note that a knowledge base system must be properly setup for this feature to work. Further a 
task template should be defined before it can be associated with the solution being 
contributed.

To contribute to knowledge base:

1. In the Service Request window, create a service request, or query an existing service 
request.

2. Click on the Search Knowledge Base button in the Workbench tab to open the 
Knowledge Base Search window.
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3. Select the notes on which you want the search to be based and run a search for 
solutions. For more information on searching knowledge base, Searching the 
Knowledge Base from a Service Request.

4. Add useful results on the top section by clicking the add button.

5. To contribute to the knowledge base, select the notes and the saved knowledge base 
elements and click the contribute button. A solution set is a collection of knowledge 
elements and depending on the type of the solution, needs to have a minimum set of 
knowledge elements like Symptom, Cause, Action or Problem/Resolution. 

6. The Contribute window (same as solution details screen) comes up. The selected notes 
and knowledge elements are defaulted. The product field is also defaulted. Additional 
products can be associated with this solution by adding to the product field.

7. Enter a Solution Summary.

8. Select the type of the solution set.

9. Optionally enter a task template that you want to be associated with the solution.

10. Click on the Submit button to contribute the solution set. The new solution will be 
available for searching once the concurrent manager has processed this request.

11. The solution details window closes and the user returns to Search knowledge base 
window.

Creating, Viewing and Updating Tasks from a Service 
Request

Service request provides the functionality for creating, assigning, managing, and prioritizing 
various tasks through its Tasks tab. A task is a unit of work that needs to be completed. 

After you create a service request, you can create tasks for yourself or assign tasks to other 
resources to manage the work and business practices required for resolving the customer 
issue. 

Note that the workflow you want to launch must be associated with the task type.

To create or update a task:
1.  Navigate to the Service Requests window and create a service request or open an 

existing service request.

2. Click the Tasks tab. The task type, status, priority, owner and owner type are defaulted. 
These defaulted values can be changed.
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You can create a task directly or use a task template to create one or more configured 
tasks.

3. If you want to create a task from a template group: 

a. Click Use Template. The Create Tasks from Template Group window opens. 

b. Select a template. The source name, owner type and owner get defaulted from the 
service request.

c. Click Create Tasks.

4. If not using a task template to create a task:

a. Enter a name for the task.

b. Enter a brief description of the task in the Description field. Values for status, type, 
priority, owner type, owner, assignee, and assignee type are defaulted based on the 
service request and profile option.
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c. Optionally, enter a Parent task for this task. (You can establish parent child 
relationship between tasks).

d. Optionally, select the restrict closure flag. A task with restrict closure means that 
the service request cannot be closed until this task is closed.

e. Optionally, enter planned, scheduled and actual start and end dates

f. Optionally, enter planned and actual effort and the duration of the effort.

g. Optionally, click More button to define Resource Requirements, Resource 
Assignments, Task Dependencies, etc. The Task Details window opens.

h. In the Resource tab, define Resource Requirements by selecting resource type, 
units and click on enabled checkbox.

i. In the Resource tab, the assignment section shows the resources which are assigned 
to this task. Select a resource type, name and status.
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j. In the Dependencies tab, enter the task dependencies by selecting the task number 
and the offset duration.

k. In the References tab, enter the reference document type and the number and select 
the type of reference of this task with this document.

l. In the Contacts tab, you can associate contacts for this task.

m. In the Miscellaneous tab, you can enter details like currency, cost, autonotification, 
etc.

n. The Audit tab shows the audit history for the fields task status, task type, task 
priority, owner, owner type, assigned by, customer account number, customer 
number, address, planned end date, scheduled end date, actual start date, source 
object id, source object number, duration, duration UOM, etc.

o. In the Recurrences tab, enter the recurrence rules.

p. Save your task. A task number is generated and the new task appears in the 
spreadtable on the Task tab.

5. Click Launch Workflow to launch a predefined workflow which can be associated 
with a task type in the task type setup.

6. If you want to update a task, then perform the following steps:

a. Select a task to be updated by clicking on that task row in the spreadtable (task list).

b. Update information in any field and save your changes.

Creating and Viewing Notes in Service Requests
Notes in a service request help in recording the descriptive information about customer 
issues, any progress done by an agent in resolving this service request etc. Notes are used to 
capture details that will be used to search the knowledge base for solution statements. Notes 
are also used to create new solution statements that will be contributed to the knowledge 
base. 

To create a note:
1. Navigate to the Service Requests window.

2. Create a service request or open an existing service request.

3. Open the Workbench tab.
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4. Select a note type and note status in the appropriate fields. There are system profile 
options that specify the defaults for these fields.

5. Enter a brief description of the note in the Note field.

6. In case you want to enter more text for the notes, click on details button to open the 
Note details window. Now you can enter additional text for this note. The Detailed 
Notes window holds textual notes up to 32 K in size.

7. Save the note.

8. The note appears in the spreadtable under the Notes and Knowledge base elements area.

9. In case you want to specify more details to the note like related to and related values 
fields while creating a note, access the main notes window by selecting the Notes option 
on the tools menu. This brings up the Notes window.

This window allows a user to create a note while specifying related to and related to 
value (The related to field has many seeded values like service request). When a service 
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request is created, it by defaults related it to service request and assigns the service 
request number to the related to value field.

10. The Notes windows shows notes on two tabs: Notes and Summary. The Notes tab 
shows the notes in a summarized list form in a spreadtable. The summary tab displays 
the notes as text in a chronological or reverse chronological order. You can change the 
chronological view by clicking on the Latest First checkbox.

11. To find a note:

a. Open the Notes window. 

b. Click on the Find tool bar button to open the Notes Find window. Enter the 
appropriate search parameters and click the Find button.

Reference:
n Creating a Service Request

Viewing Customer Interactions
The Interactions tab of the service request displays the entire contact history for the service 
request. You can also view all interactions across your company. For example, you can view 
all closed interactions in this tab. Closed interactions occur when a support agent uses the 
End Interaction button after the interaction is complete.

To record and view customer contact interactions:
1.  Navigate to the Service Requests window and create a service request or open an 

existing service request.

2. The Interaction tab displays the various interactions that your organization had in the 
past with this contact.

3. In the Interactions tab, click on All Interactions buttons

The Interactions tab displays all the interactions that this customer had with your 
organization.
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Managing Service Request Contacts
Companies often provide multiple contacts for a service request. In such cases, you can use 
the Contacts tab in the Service Requests window to record additional contact information.

Note that contacts must be defined before they can be associated with service requests. To 
update existing contact information or create new contacts, access the Quick Menu and 
navigate to the Contact Center window.

To record a contact for a service request:
1. Navigate to the Service Requests window and create a service request or open an 

existing service request.

2. Click the Contacts tab.

Contact information from the service request is displayed in this tab.

3. To associate other contacts with this service request, select the contact type and the 
contact’s first and last name. Contacts can be for the select customer or for Employees. 
and they must exist in Human Resources. Select desired contact point information.

4. Indicate who the primary contact is by checking the Primary checkbox next to the 
desired contact. This will change the primary contact in the Service Request header It 
will also default the selected contact point information into the appropriate field.

5. Save the service request. The contact details are saved along with the service request.

6. Use the Quick Menu if you want to create a new contact.

7. Use the Quick Menu if you want to edit existing contact information.

Reference:
n Creating a Service Request

n Navigating using Quick Menu

Managing Customer Addresses
The Address tab contains customer contact address information for Installed At, Bill To and 
Ship To location types: To update or add new addresses navigate to the Contact Center using 
the Quick Menu.
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To record customer address information:

1. Navigate to the Service Requests window and open an existing service request. The 
application populates the Service Requests window with the customer data entered in 
the Contact Center.

2. In the Addresses tab, select an address from the list of values in the appropriate 
sections: Bill To, Ship To and Installed At. In case the service request is logged against 
a customer product, the Installed At address is taken from Installed Base.

3. Save the service request to record the address information.

Viewing the Service Request Log
The Log tab provides a useful reference to the history of a service request. It shows all the 
notes entered for a service request, any changes to the audited fields, creation and update of 
tasks, task notes etc. in a chronological way.
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Note that you must save the service request before you can view the log.

To view the customer contact log:
1. Navigate to the Service Requests window and open an existing service request.

2. Click the Log tab. This tab displays the history associated with the service request.

3. Select Previous or Next buttons to navigate to the previous or next section of a log.

4. Selecting the Latest First checkbox arranges the history in the log chronologically.

References:
n Viewing Customer Interactions

n Creating a Service Request
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Linking Related Documents to a Service Request
You can link a document to one or more service requests. For example, if several customers 
report the same problem occurring in a software product, you can link these service requests 
together, or link each of these service requests to the service request that contains a thorough 
description of the software resolution.

A service request can also be linked to a defect. When a defect is created from a service 
request, it automatically creates a link between the defect and the service request.

When a service request is created by using the copy command from a service request, you 
can, optionally, create a link between these two service requests. 

To link related documents to a service request:
1. Navigate to the Service Requests window and open a service request.

2. Open the Related Documents tab.

3. The related to tree on the left side of the Related Documents tab. You can expand a node 
on the tree by single clicking on the + sign. The details of the document selected on the 
tree are displayed in the fields on the right side of the tab.

4. In the Related Documents tab, select the document type and the document number to be 
related to this service request.

The Summary, Product, Status, and Severity fields for the selected document are 
displayed.

5. Select a link type from the Link Type field.

6. Save service request to link the selected document to the service request.

7. You can delete a link by selecting a document on the tree structure and clicking on the 
Delete Link button.

8. By clicking on the related from check box, the service requests which linked this service 
request to them are displayed.

References:
n Finding a Service Request

n Creating a Defect from a Service Request
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Finding a Service Request
Use the Find Window to retrieve service requests from the database or product information 
from the installed base. Oracle Customer Support provides two search levels: Basic and 
Advanced. Basic search is selected by default.

Basic search enables you to retrieve service requests based on parameters related to a service 
request (number, owner, customer, product, or status), a task linked to a service request (type 
status, assignee, or number), or a text string available in the request summary or the note 
associated with a service request. You may also use a combination of these parameters to 
restrict your search so as to retrieve only the service requests you want.

Advance Search enables you to specify a number of logical arguments or conditions based 
on which the service request is to be retrieved. 

On executing a search, the service request(s) matching your search parameters are displayed 
in the results area of the Find window. You can select any of the retrieved service requests 
and then click OK to view its details in the Service Requests window.

To find a service request using basic search:
1. Select the parameters based on which you want to search for the service request. You 

may select from the following parameters:

n Service Request Number

n Service Request Owner

n Service Request Status

n Service Request Customer

n Service Request Product

n Task Type

n Task Status

n Task Assignee

n Task Number

n A text string in Service Request Summary and Notes
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2. If you are performing the search using a text string as the parameter:

a. Select a search option to indicate how the text string you enter in the Keywords 
field is to be used for the search. You may select from the following options:

Any Word: Finds service requests that contain any of the keywords in summary or 
notes.

All Words: Finds service requests that contain all the keywords, in any order, in 
summary or notes.

Phrase: Finds service requests that contain an exact match as the keywords in 
summary or notes.

b. Select where the search is to be performed. Select:

Summary check box to search only in the request summary

Notes check box to search only in the notes associated with service requests.

Both Summary and Notes check boxes to search in both the service request 
summaries and notes.

c. Enter the text string to be used for the search in Keywords field.
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3. Click Search to find matching service request(s) based on the parameters you have 
specified.

To find a service request using advanced search:
1. Click on the Advanced tab.

2. Define the logical condition(s) to be satisfied for identifying and retrieving service 
request(s). You may build your arguments around customer number, contact name, 
severity level, etc. To define an argument:

a. Select the item for which the argument is to be defined.

b. Select a logical operator to indicate how the item and value combination is to be 
used to identify service requests.

c. Select the value based on which service requests are to be retrieved.

Note: Each item, condition, and value combination is considered an argument. The 
AND operator is used in the background to create a complex argument if you define 
more than one condition. All the conditions set forth by a complex argument must be 
satisfied for identifying and retrieving service requests.

3. Click Search to find matching service request(s) based on the arguments you specified.
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References:
n Creating a Service Request

n Creating Viewing and Updating Tasks from a Service Request

n Creating and Viewing Notes in Service Request
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n
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This section explains how to use the options in the Tools menu to perform essential business 
tasks. This section covers the following topics:

n Entering Quality Results

n Sending a Copy of the Service Request Using Fulfillment

n Managing Workflows

n Viewing Service Request Audit History

n Creating Defects from Service Requests

n Creating Enhancements from Service Requests

n Sending Messages

n Viewing and Responding to Messages

n Viewing Message History

n Recording Counter Readings

n Billing for Charges from Service Requests

n Escalating a Service Request

n Escalating a Service Request Task

n Copying a Service Request

n Navigating using Quick Menu 

Tools Menu options are enabled only when the particular function would be allowed. For 
example, the Escalate Service Request option would be enabled only after you have created 
a service request.
                                                            Using the Service Requests Tools Menu 1-33



Entering Quality Results
Entering Quality Results
From service request, you can directly enter results into a Quality Plan to collect quality 
information configured in the Quality Plan.

For this feature to work, a predefined quality plan should be available. 

To enter quality results:
1. Navigate to the Service Requests window.

2. Create a service request or open an existing service request.

3. From Tools menu, select Enter Quality Results option.

Sending a Copy of the Service Request Using Fulfillment
From within service request you can send a copy of the service request by email or fax using 
the integration with Fulfillment. 

Fulfillment must be setup before you can send service requests reports using fulfillments.
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To send a copy of the service request using fulfillment:
1. Navigate to the Service Requests window. 

2. Create a service request or open an existing service request.

3. From Tools menu, select Fulfillment Request option. The Fulfillment Requests window 
opens. From this window, you can select to email or Fax fulfillment request. You can 
also enter additional information before sending the request.

Managing Workflows
From within service requests you can directly launch and abort workflows. Each service 
request type can be associated with a pre-configured workflow. When the service request is 
created, the workflow associated with the service request type can be configured to start 
automatically. You can configure an option to abort the workflow automatically when the 
service request is closed. No automatic workflow processing is done if the service request 
type is changed.

You may manually launch or abort a workflow from within service request. The Service 
Request module provides the Active Workflow checkbox to indicate if an active workflow is 
in progress. This checkbox is located in the service request header in the folder block. To 
view the name of the workflow, from the Define Service Request Type window, run a query 
using the service request type with which the workflow is associated as the query criterion.

You must configure request types to use Oracle Workflow business processes before you can 
launch a workflow from a service request. 

Launching Workflows

To launch a workflow:
1. Navigate to the Service Requests window. 

2. Create a service request or open an existing service request.

3. From Tools menu, select the Launch Workflow.

4. Select Yes to start the workflow 
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Aborting a Workflow

To abort a workflow:
1. Navigate to the Service Requests window. 

2. Open a service request or create a new service request.

3. Verify that the Active Workflow checkbox, in the service request header area, is 
checked. Note that you may need to scroll down to view the fields in the folder block 
area.

4. From the Tools menu, select Abort Workflow.

5. Select Yes to stop the workflow.

Viewing Service Request Audit History
You can view the audit history tracked for changes made to a service request. The only fields 
audited in the service request are:

n Owner

n Type

n Urgency

n Severity

For each audit record, information such as the user name of the person who made the 
change, date and time when the change was made, and the value both before and after the 
change are recorded.

To view service request audit history:
1. Navigate to the Service Requests window.

2. Create a service request or open an existing service request.

3. From the Tools menu, select Audit History. The Audit History window opens.

4. Enter the duration dates for the audit history information.

5. Select the service request field you want to audit from the list of values in the Audit 
field.

6. Review the audit history.
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Creating a Defect from Service Requests
From within service requests you can directly create a defect. Defects are issues relating to 
inventory items. Once the problem reported in the service request has been determined to be 
a product defect, use this procedure to create a defect from service requests. 

Note that the Defect Management System must be properly configured for this feature to 
work. See Implementing Defect Management in the Oracle Support Implementation Guide 
for more information.

Defect Management System must be installed for this function to be enabled.

To create a defect from service requests:
1. Navigate to the Service Requests window.

2. Create a service request or open an existing service request.

3. From the Tools menu, select Enter Defect. The Defect & Enhancement window opens.

4. Enter the mandatory product information by selecting from the list of values for the 
Product, Product Revision, Earliest Product Revision fields.

If the inventory item identified in the service request, either from installed base or from 
the product, is flagged as Defect Tracking Enabled, product information will be shown 
by default. 
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5. Optionally, enter component, component version, subcomponent and subcomponent 
version details.

6. Enter the mandatory problem information by selecting from the list of values for the 
Category, Phase, Status, Type, and Severity fields. These values are setup based on 
unique business processes.

7. For software inventory items, enter the hardware tier associated with the product defect.

8. Enter keywords. Keywords are used as an advanced feature in the Defect Management 
System’s search functionality.

9. Enter a description (mandatory) of the defect in the Summary field.

10. Select the Publish checkbox to make the defect available for viewing externally. 

11. Enter a note to describe defect in full detail. If a product defect template is setup for the 
identified product, a special defect template is populated in the Note field. This template 
would then be used as a guide in describing the defect.

12. Select the Relate to Request checkbox to create an automatic link to the service request 
for this defect. Defects linked to service requests are listed in the Related Documents 
tab in the Service Request window. This allows for notification communication between 
the defect and service request.

13. Click Save to create the defect. A defect number is automatically assigned to the defect.

14. Click Save and Open to launch the HTML Defect Management functionality and show 
default values in the Defect Detail window. This allows the user to update the newly 
created defect using the HTML Defect Management functionality, as needed.

15. Click Close to return to the service request.

Creating an Enhancement from Service Requests
From within service requests you can directly create an Enhancement Request. 
Enhancements are improvements to existing inventory items. 

Enhancements and defects are both tracked and managed in Defect Management. Follow the 
procedure identified in Creating a Defect from Service Requests. When creating an 
enhancement, select Enhancement Category from the list of values.

See Implementing Defect Management in the Oracle Support Implementation Guide for 
information on setting up enhancements

Defect Management System must be installed for this feature to be enabled.
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Managing Messages in Service Request
Messages can be send and viewed from the service request. The Messages feature leverages 
Oracle Workflow to send and view messages. For example, you can send a message for a 
specific service request from the Service Requests window that contains a request for action. 
In this case, a response is required of the message’s recipient to indicate whether the action 
is accepted, rejected, or completed. In addition, you can choose to have a confirmation sent 
to you once the recipient has responded to your message.

Sending Messages
Oracle Workflow must be configured before you can send messages.

To send messages:
1. Navigate to the Service Requests window.

2. Create a service request or open an existing service request.

3. From the Tools menu, select Send Message. The Send Message window opens.

4. Enter the sender’s name in the From field.

You can enter any value, or use the list of values to select from all roles defined for use 
with Oracle Workflow. The default value is the Workflow display name of the current 
user; if the user’s Workflow role cannot be determined, the FND user name defaults.

5. Select a Priority from the list of values.Three priorities are provided with the Message 
feature (High, Medium, Low) and Medium is the default value. These Priorities are not 
user definable and are not related to Oracle Workflow notification priorities.
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6. Select an Action from the list of values.

For more information, see Defining Action Requests in Oracle Support Implementation 
Guide.

7. Enter the recipient’s name in the To field. Note that the recipient’s name must be 
defined in Oracle Workflow roles.

8. Check Expand Roles if you plan to send this message to a Workflow role that includes 
several individuals and if you want each person to receive a copy of the message.

n By default (if this box is not checked), one message is sent to the role as a whole. If 
one individual responds to or closes the message, the message is removed from the 
inbox of all other individuals in that role.

n If you check Confirmation, you will not be able to check Expand Roles.

9. Optionally, check Confirmation if you want to receive a confirmation message once the 
recipient has responded to your message.

n If you check Confirmation, the From field is validated to ensure that the sender is a 
valid Workflow role. 

n If you check Expand Roles, you will not be able to check Confirmation.

10. Enter your message text.

11. Click Send to pass the message to Oracle Workflow for delivery and processing.

Viewing and Responding to Messages
These messages will also appear in the Universal Work Queue along with other Oracle 
Workflow notifications. They may also appear in your email application, a Web page or 
Oracle Workflow Notification Summary window based upon your Oracle Workflow 
configuration.

To view and respond to messages:
1. Navigate to the Universal Work Queue.

2. Select a message and open it by double clicking on the message.

The Notifications window appears.

3. Choose Respond and choose your response from the Result list.

If the message does not include an action request, you must respond with Acknowledge. 
Otherwise, choose one of the following responses:
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n Accept if you accept the responsibility of performing the requested action.

n Reject if you reject the responsibility of performing the requested action.

n Done if you have completed the action.

4. Optionally enter additional comments, such as your reason for rejecting the request.

5. Choose OK.

A confirmation message will be sent to the original message’s sender if and only if the 
sender checked Confirmation.

Viewing Message History

To view message history for a service request:
1. Navigate to the Service Requests window.

2. Open a service request.

3. From the Tools menu, select Message History.

The Message History window appears, displaying sender, recipient, and response 
information for all messages that were sent concerning the service request.

Recording Counter Readings
From within service requests, you can update any Counters associated with a specified 
product, installed base item or product.

For this feature to work, a service request for a product or installed base that has a counter 
defined and instantiated must be available. See the Oracle Service Implementation Guide for 
more information.

To record counter readings from service requests:
1. Navigate to the Service Requests window.

2. Create a service request or open an existing service request.

3. From Tools menu, select Counter Capture. The Capture Counter Reading window 
opens.

4. Enter the New counter value, miscellaneous reading information or reset the counter.

5. Click Save.
                                                                Using the Service Requests Tools Menu 1-41



Billing for Charges from Service Requests
Billing for Charges from Service Requests
Using the charges capability, a service organization can bill customers for services provided 
for services, repairs and returns.

To bill for charges:
1. Navigate to the Service Requests window.

2. Create a service request or open an existing service request.

3. Click on Tools.

4. Select Charges. The Charges window opens.

5. Enter the Charges information.

6. Click Save.

Escalating a Service Request
Using the escalation functionality you can create an escalation document for critical 
situations involving one or more service requests. The escalation document will raise 
awareness and enable swift action to manage and resolve the situation. The escalation 
document is assigned to an owner, tracks the business situation information, requester, 
additional contacts, and all actions taken toward resolving the situation. The escalation 
document can also identify or escalate related service requests, defects and tasks as required.

A service request that is escalated will show the level to which it has been escalated. 
Escalation levels are user defined; they represent the degree of visibility. The default value 
of Not Escalated is associated with all service requests that have not been escalated. 

The current escalation level of a service request is displayed in the Escalation Level field on 
the Service Request window. You will need to scroll down on the header region of this 
window to view this field. 
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Also, a system profile option is available for setting the color of the service request number 
when the service request is escalated. See Oracle Support Implementation Guide for more 
information on using this profile option.

Notifications are an integral part of the escalation functionality. Oracle Workflow is used to 
process and deliver the notifications regarding escalation activity. Notifications are sent for 
the following reasons:

n Escalation creation

n Escalation status changes

n Escalation owner assignment and changes

n Escalation level changes

Notifications can be sent to a variety of recipients, depending on the system profile options 
set. Typical recipients include:

n Owner of the service request

n HR manager of the service request owner

n Escalation Territory member or the Primary Contact
                                                                Using the Service Requests Tools Menu 1-43



Escalating a Service Request Task
To escalate a service request:
1. Navigate to the Service Requests window.

2. Create a service request or open an existing service request.

3. From the Tools menu, select Request Escalation. The Escalations window opens.

4. Enter the escalation information. The customer information and service request will 
default. The mandatory fields are Escalation Owner, Contact Requester, Escalation 
Level and Status.

5. Click Save. An escalation number will be assigned. Notification will be sent based upon 
the escalation management setup and system profile options.

Escalating a Service Request Task
Using the escalation functionality you can create an escalation document for critical 
situations involving one or more task in a service request. The escalation document will 
raise awareness and enable swift action to manage and resolve the situation. The escalation 
document is assigned to an owner, tracks the business situation information, requester, 
additional contacts, and all actions taken toward resolving the situation. The escalation 
document can also identify or escalate related service requests, defects and tasks, as 
required.

The procedure to escalate a task is the same as the procedure to escalate a service request. 
For more information, see Escalating a Service Request.

To escalate a service request task:
1. Navigate to the Service Requests window.

2. Create a service request or open an existing service request.

3. Open the Task tab.

4. Select the task to escalate.

5. From the Tools menu, select Task Escalation. The Escalations window opens.

6. Enter the escalation information. The customer and task information will default. The 
mandatory fields are Escalation Owner, Contact Requester, Escalation Level and Status.

7. Click Save. An escalation number will be assigned. Notification will be sent based upon 
the escalation management setup and system profile options.
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Navigating using Quick Menu
Copying a Service Request
Copy Request allows a user to create a new service request by copying the information from 
an existing service request.

To copy a request:
1. Navigate to the Service Requests window.

2. Open a service request of create a new service request.

3. From the Tools menu, select Copy Request. The Copy Service Request window opens.

4. Change any of the defaulted Copy To Request information; Type, Severity, Owner, 
Urgency, Customer, Account, Summary. This information will be used to create a new 
service request.

5. Check the desired Include checkboxes to copy additional information into the new 
service request.

6. Check the following Reference link options; No Link, Create Reference Link, Create 
Duplicate Link. If you check Create Reference Link or Duplicate Link a Reference link 
will be established, in the new service request only, for the service request used to create 
the copy. This Reference link is available in the Service Request Reference tab.

7. Click Copy. The new service request will be created and the user will be presented with 
that service request to enable updates.

Navigating using Quick Menu
Quick Menu allows you to navigate to other windows using information on the window 
prior to navigating to a new window. For example, to update a contact’s email address from 
an existing service request you would select from the Quick Menu, Contact Center. The 
Contact Center window would be opened defaulting in your contact information from your 
service request.

To access the quick menu:
1. Navigate to the Service Requests window.

2. Open an existing service request or create a new service request.

3. From the Tools menu, select Quick Menu, The Quick Menu window opens.

4. Select the desired menu option. A new window opens and defaults in specific 
information from your service request. The information defaulted in is seeded, 
pre-defined, and is not user-definable.
                                                                Using the Service Requests Tools Menu 1-45



Navigating using Quick Menu
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Understanding Defect Management

This topic group provides overviews of Defect Management, explanations of key 
concepts, features, and functions, as well as the application’s relationships to other 
Oracle or third-party applications. 

User Interface Basics
Here are some of the basic concepts to help you understand the user interface:

User Interface Elements

Element Description

1 Links for exiting the application, changing user preferences 
and viewing context sensitive help. 

2 Tabs that open up different windows. The selected tab appears 
light blue.

3 Subtabs that open up different windows. The selected subtab 
appears light blue.

4 A search box that allows you to search for a defect by defect 
number.

5 Link to the Advanced Search window where you can perform 
an advanced search.
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What is Defect Management?
List of Values

The Go! button next to a text box indicates that the user can only enter specified 
values in this field. If you do not know the value you enter here, then click Go! to 
bring up a window list of values (LOV) associated with the field. See Using the List 
of Values. A red asterisk next to this field tells you that entry is required.

Drop-down List

A text box with a down arrow next to it tells you that you select the entry from a 
drop-down list. Click on the down arrow and make your selection. The red asterisk 
next to this particular field indicates that entry is required.

Text Box

A plain text box (without a drop-down list or Go! button) indicates you can type 
free text here.

Red Asterisk
A red asterisk next to a field indicates entry in that field is required.

What is Defect Management?
Defect Management provides a structured repository of information about defects 
and enhancements and a method of tracking those defects and enhancements 
through an organization from the time they are filed until they are fixed, tested, and 
documented.

Your organization can use Defect Management to classify and prioritize defects and 
enhancement requests and to store all relevant information. This includes notes, 
files, and error codes. 
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How Out of Box Phases Control Defect Resolution
You can also use Defect Management to control the way a defect gets passed from 
team to team and person to person within your organization. The application relies 
on a series of configurable phases that through integration with CRM Territory 
Management determine who has ownership.

Changing the phase of a defect triggers the CRM Territory Management and 
Assignment Manager which automatically assign the defect to the team or 
individual who will handle the defect in the next phase. The individual handling 
the defect in a phase is its owner.

The movement of defects through the different phases is flexible. You can close the 
defect any time or send it back to the previous phase if you are not satisfied that the 
previous phase has been completed. A defect that has been sent back to the 
previous phase automatically reverts to the previous owner. 

The application keeps an audit trail of all changes.

How Out of Box Phases Control Defect Resolution
The progress of defects and enhancement requests from one stage to another is 
governed by phases. All are configurable by the application administrator.

Defect Management breaks down the defect cycle into five seeded phases tailored 
for use by software companies. These are: 

� Define

� Respond

� Resolve

� Verify 

� Document

Customers can add their own additional phases.

The way a defect moves from one phase is not rigid. Agents can close a defect at 
any time, send it to a previous phase for more clarification or override the phases 
and assignments altogether.

Your system administrator can set up CRM Territory Management and Assignment 
Manager to automatically assigns a defect to an agent handling each phase. CRM 
Territory Management can also be set up to assign defects based on the defects 
product, component, platform and most other defect attributes. You must set up 
territories and implement the Assignment Manager to use this feature.
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How Out of Box Phases Control Defect Resolution
Here is how the default phases are designed to work:

Define
The filer enters information about the product and the defect. This includes the 
component affected, the defect severity, and the type of defect involved. 

Your system administrator can prepare templates of questions the filer has to 
answer. You can draw up different question templates for any combination of defect 
types, products, product modules. The information you want to collect for an 
enhancement request is very different from what you need for a critical software 
bug. Defect Management can link to a service request, giving users the ability to 
drill down to see the service request details.

After the defect is saved, the CRM Territory Management and Assignment Manager 
modules automatically assign the defect to an agent handling the Respond phase. 
The new owner of the defect receives notification via an e-mail and the Universal 
Work Queue.

Respond
The owner of the Respond phase responds to the defect and gives the filer an idea 
when a fix is forthcoming. 

The responder screens the defect or enhancement to ensure it is filed correctly and 
does not duplicate one that is already in the company’s Knowledge Base or in the 
Defect Management system itself. Responders can close duplicate defects and send 
defects back to the filer for more information.

If the defect is legitimate, then the responder makes a decision on its development 
priority and makes a promise to fix it. The responder then changes the phase to 
Resolve.

Once the defect is updated to the new phase, Territory Management automatically 
assigns the defect to the appropriate team. A defect that is changed to the Resolve 
phase is typically assigned to a team as a whole rather than to an individual in the 
team. It is up to the team’s manager or the team members themselves to decide who 
will handle what defect. 

Resolve
The purpose of the Resolve phase is to assign the defect to the appropriate 
individual to resolve the defect, and then to gather information about the fix or 
enhancement once it has been carried out.
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How Out of Box Phases Control Defect Resolution
The engineer who fixes the defect enters information about what version of the 
product has been fixed and what files have been modified. The engineer also 
indicates whether:

� The information is to be contributed to the company Knowledge Base, making 
an edited version available internally to the company and to its customers. 

� The fix required functional and interface changes. This alerts quality assurance 
and documentation of possible changes they have to make in their test plans 
and documentation. 

The engineer can close the defect at this stage or change the phase to Verify. This 
triggers Territory Management and Assignment Manager to assign the defect to a 
quality assurance (QA) engineer. 

Verify
The verify phase is designed to record the testing that has been performed to make 
sure the fix works.

The QA engineer enters the types and names of tests carried out. If the defect 
requires documentation, then, depending on the predefined business rules, the QA 
engineer changes the Phase to documentation.

The defect is automatically assigned to the technical writer in charge.

Document
The technical writer updates the documentation or release notes and closes the 
defect.
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How Out of Box Phases Control Defect Resolution
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Using Defect Management

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks.

Using the List of Values (LOV)              
Use this procedure to enter values in fields using the list of values (LOV). The LOV 
is the window which appears when you click Go! next to a field.

To use the list of values:
1. Click Go! next to a blank entry field.

The list of values window appears listing the available entry values for the 
field. 

2. If the list is too long, then you can narrow the selection down:

a. Enter a partial or full value

b. Click Go!.

The list of values displays a shorter list.

3. Click on the entry of your choice.

You are taken back to the window where you are making your entry. The field 
displays your choice.
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Using the Profile Window
Using the Profile Window
You can use the Profile window to:

� Change your password

� Create Defect Summary Views

Changing Your Password

To change your password.
1. Click the PROFILE link at the top right of the Defect Management window.

The Profile window appears.

2. Click the Change Password link.

3. The Change Password window appears.

Change your password.

4. Click Update.

Searching for a Defect
Use this procedure to search for a defect. If you wish to reuse the same search 
multiple times, you can instead create permanent views by following the procedure 
outlined in Creating Summary Views.

To search for a defect:
1. If you know the number of a defect:

a.  Enter it in the Quick Search text box.

b. Click Go!.

2. If you do not know the number of the defect, then click the Advanced Search 
link.

The Defect Search window appears.
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Creating a Defect or Enhancement Request
3. Enter your search terms in the fields provided.

4. Click Go!.

Checking for Duplicate Defects
Note that you must be able to log on to iSupport or Service Request for this search 
to work properly.

To search for duplicate defects:
1. Search the Knowledge Base for information about related defects through 

Support or iSupport. 

2. Perform an advanced search. See Searching for a Defect.

Creating a Defect or Enhancement Request
Note that you must have a valid account for creating an enhancement request.

To create a defect or enhancement request:
1. Make sure nobody has entered a similar defect. See Checking for Duplicate 

Defects.

2. Select the Create subtab.

3. In the Product Information region, make entries in as many fields as possible 
using the list of values (LOV) in each field. Although only fields marked by red 
asterisks are required, your entries in other fields affect how the defect is 
handled. Enter information even if you are not sure that it is correct.

Note: This version of the application does not support text 
searches, so you cannot search the keyword, summary, or note 
fields.

Note: Because the Knowledge Base requires the intervention of a 
human editor before defect resolution information is posted, it may 
be a few weeks out of date.
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Creating a Defect or Enhancement Request
a. In the Product field, use the LOV to enter the product name. Entry in this 
field is required.

b. In Product Version field, use the LOV to enter the product version. Entry in 
this field is required. (The use of the LOV is optional.)

c. In the Earliest Version field, use the LOV to enter the earliest version of the 
product where the defect has been reproduced. The version you enter here 
can be the same you entered in the Product Version field. Entry in this field 
is required. (The use of the LOV is optional.)

d. For products that have components, use the Component field LOV to enter 
the component. This can be a module or a feature.

e. If you entered a component, then use the LOV to enter a Component 
Version. (The use of the LOV is optional.)

f. Using the Platform LOV, enter the platform.

g. If you entered a platform, then use the Platform Version LOV to enter a 
version. (The use of the LOV is optional.)

4. In the Problem Information region, use the Category drop-down list to select 
whether you are entering a defect or enhancement. Entry in this field is 
required.

5. From the Type drop-down list, select the type of defect that best describes the 
defect you are reporting. 

6. From the Phase drop-down list, select Respond. Entry in this field is required.

7. From the Status drop-down list, select Awaiting Response. Entry in this field is 
required. 

8. Select the level of severity using the Severity drop-down list. Entry in this field 
is required.

9. From the Frequency drop-down list, select the frequency which corresponds 
most closely with the frequency you are experiencing with the defect. If you are 
entering an enhancement, then you can skip this step.

10. If you know that the defect affects only a specific language product, then make 
a selection from the Language drop-down list. Otherwise leave the selection as 
All Languages. This is the default. 

11. From the Tier drop-down list, select where you think the problem is occurring. 
If you do not know, then use your best judgement.
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Creating a Defect or Enhancement Request
12. Unless you are entering a backport, leave the Base Defect field blank. A 
backport is a request to have an existing fix from a different platform applied to 
the current defect. If you are entering a backport, then enter the defect number 
where this problem is fixed.

13. Enter any keywords in the Keywords field, or leave the field blank.

14. In the Summary field, enter a summary that will help others identify the defect 
or enhancement. 

15. If there are any error messages that appear as a result of the defect, then use the 
LOV in the Error Codes region to enter them. 

16. Make sure that the Published check box is checked. This makes your defect 
visible to customers and others outside your organization.

17. Answer any questions that appear in the Problem Description at the bottom of 
the window. These questions can change depending on the product, 
subcomponent, or defect type you enter. 

18. Click Create.

The Defect Detail window appears.

19. Use the links at the top of the window to enter optional related information:

� Contacts. If you know other individuals than yourself who should be kept 
up to date about this defect, or if you wish to change the person designated 
as a primary contact for this defect, follow the instructions in Changing 
Who Gets Notified.

As the defect filer, you automatically become the primary contact for this 
defect or enhancement and the owner of the defect in the definition phase.   
You are notified automatically every time the defect gets updated. If the 
phase is changed back to the definition phase, then you automatically 
become the owner of the defect again.

Note: If your error messages do not match any of those in the 
LOV, then enter them in the problem description instead.

Note: Always leave entering the problem description until last. 
You must not change the Product Information region fields once 
you enter the problem description because you may lose your entry.
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Changing Who Gets Notified
You may wish to define a different individual to be the primary contact and 
the owner of the defect in the definition phase, if you are entering the bug 
on behalf of a customer or a colleague, for example, or if you are about to 
go on vacation.

� Related Documents. If there are any related defects or service requests, 
click the Related Documents link to enter them.

� Tasks. If there are any tasks you need to assign to others, then click the 
Tasks link to enter them. The tasks you create appear on the Universal Work 
Queues of the individuals you assign them to. You need no special 
permission to assign a task to another person in the organization.

� Attached Files. If you like to attach files or URLs to the defect, then click 
the Attached Files link to make your entry.

20. Click Update.

Your defect is automatically assigned to an available engineer. You will be 
notified by e-mail each time the defect is updated or if the responder requires 
any more information to proceed. If the responder changes the phase back to 
the definition phase, then you automatically become the owner of the defect 
again.

Changing Who Gets Notified
Use this procedure to change the list of the people who are automatically notified of 
the progress of a defect and to change the primary contact.

Note that You must be the owner of a defect or have the authorization to modify a 
defect to be able change the list of the people who are automatically notified of the 
progress of a defect.

To change the notification list:
1. Navigate to the Defect Detail window.

2. Click on the Contacts link at the top of the window.

3. If you wish to add a contact then:

a. Use the Name List of Values (LOV) to add the contact.

b. Select the notification method.

c. Using the Notification Condition LOV, determine when the contact is to be 
notified.
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Creating Defect Summary Views
d. Click Update.

4. If you wish to change the primary contact for a defect, then select the Primary 
radio button next to the new primary contact.

 The primary contact is the owner of the defect in the definition phase and the 
person who is responsible for reopening the defect if the fix provided by 
engineering does not solve the business problem. 

The person filing the defect is automatically made the primary contact.

Viewing Defects Assigned to You
Use this procedure to view the defects assigned to you.

To view defects assigned to you:
1. Click the Summary link at the top right of the Defect Management window.

2. From the Please select a View drop-down list, select My Defects.

The list of defects and enhancements assigned to you appears.

3. You can drill down on any defect or enhancement request you wish to view by 
clicking on its number.

Creating Defect Summary Views 
Use this procedure to configure summary views of the defects in the database 
according to the any criteria. 

Defect Management comes with two preset views: My Defects and Unassigned 
Defects, but you can configure views based on any criteria.

To create defect summary views:
1. Click the PROFILE link at the top right of the Defect Management window.

The Profile window appears.

2. Click Add View.

The Create Defect View window appears.

3. In the Columns Displayed region, select the columns you wish to use in the 
new view. See Selecting Columns for a View for details.
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Selecting the Columns for a View
4. In the Columns Ordered By region, select how you want the columns sorted. 
See Selecting the Way Defects are Sorted in Views for details.

5. In the Where Column is Equal To region, enter the conditions that must be met 
by the defect in order to appear in the view. For example, if you enter Severity = 
Critical then the view will display only defects with a critical severity.

6. Click Preview at any time to see the resulting view.

7. When you are satisfied with the view, click Update to save it.

Selecting the Columns for a View
You can select columns for a view only when you are defining a new view from the 
Create Defect View window.

To select columns for a new view:
1. If you wish to add a column or multiple columns to the new view, then:

a. Click Go! in the last row.

b. Use the List of Values (LOV) to enter the column.

c. Enter the Column Title next to the new column.

d. Click Update.

e. Repeat this procedure until you have added all the new columns you wish 
to use.

2. If you wish to delete any column, then:

a.  Check the Remove check box next to the column(s).

b. Click Update.

Selecting the Way Defects are Sorted in Views
Use this procedure to determine how you want the defects in your views sorted. For 
example, if you select to sort a view by severity, then the most severe defects will 
appear at the top of the list and the least severe at the bottom. 

You can use multiple columns to sort by. In this case, the view will be sorted by the 
columns in the order you add them. For example, you can sort the defects by 
product and then by severity. This view will yield a list of defects grouped 
epileptically by product and by severity within each product.
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Selecting Conditions for What Defects Display in a View
You can select a sort order only when you are creating a new view from the Create 
Defect View window. Further, you can only sort using the columns you have 
selected in the Columns Displayed region. 

To select the way defects are sorted in the view:
1. If you wish to add a column to sort by, then:

a. Click Go! in the last row.

b. Use the List of Values (LOV) to enter the column.

c. Click Update.

d. Repeat this procedure until you have added all the new columns you wish 
to use for sorting in the order you desire.

2. If you wish to delete any column, then:

a.  Check the Remove check box next to the column(s).

b. Click Update.

Selecting Conditions for What Defects Display in a View
You can enter conditions that determine what defects are displayed in a view only 
when you are defining a new view from the Create Defect View window.

To enter conditions that determine the defects displayed in a view:
1. Click in the Column field.

2. Click Go! and use the LOV to add a column.

3. From the Condition drop-down list, select the operator.

4. Click Go! next to the Value field and use the LOV to select a value.
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Reassigning Defects to Others
Reassigning Defects to Others
Depending on your configuration, you may require team leader privileges to assign 
defects.

To reassign defects and enhancements to others:
1. From the Summary window, drill down on the defect or enhancement request 

you wish to re assign by clicking on its number.

The Defect Detail window appears.

2. Click on the Phase link to navigate to the Phase region of the window.

3. Enter the name of the person you wish to assign the defect to in the Owner 
field.

4. Click Update. 

Assigning Unassigned Defects and Enhancements to Team Members
You must have team leader privileges to assign defects to your team members.

To assign unassigned defects and enhancements to team members:
1. From the Please select a View drop-down list, select Unassigned Defects.

2. Drill down on the defect or enhancement request you wish to assign by clicking 
on its number.

The Defect Detail window appears.

3. Navigate to the Phase region of the window.

4. Enter the name of the person you wish to assign the defect to in the Owner 
field.

5. If you wish to communicate to the filer and to customers that you will have the 
work completed by a certain release, then in the Resolution region, enter a 
version number in the Fix By Version field.

6. Click Update. 
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Responding to Newly Filed Defects
Handling a Defect Assigned to You
Just how you respond to a defect assigned to you depends on your role in the 
organization and the phase of the defect you handle. 

Different phases require you to enter different fields in the Defect Detail window.

Click on the link bellow corresponding to your role in the organization for a 
suggested procedure:

� Responding to new defects (Respond phase)

� Fixing defects and implementing enhancements (Resolve phase)

� Quality Assurance (Verify phase)

� Documentation (Documentation phase)

Responding to Newly Filed Defects
Use this procedure if you are the individual assigned to screen new defects and 
enhancements to ensure they are filed correctly and do not duplicate those already 
in the database. 

The purpose of the Respond phase of the defect process is to the filer as quickly as 
possible. Your organization can choose to track the time it takes to respond.

To respond to new defects, you must be the person assigned in the definition phase 
to respond to defects.

To respond to a newly filed defect:
1. Navigate to the Defect Detail window. See Viewing Defects Assigned to You.

2. Check to see if all the information is filled in correctly and the defect or 
enhancement makes sense. 

A single bug can cause many defects to be filed, for example, or the defect can 
be filed by a new employee who does not understand the product. 

3. Check to see if the defect or enhancement is a duplicate of one already filed.

4. If you determine the defect is a duplicate, then:

a. In Parent Defect enter the number of the duplicate defect.

b. In the Phase region, set the Defect Status to Closed.

c. In the Resolution region, set the resolution to Duplicate Defect.
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Responding to Newly Filed Defects
d. Click Update.

5. If the filer needs to fill in more details, then:

a. Set the phase of the defect back to Define.

b. Set the Defect Status to Awaiting Response.

c. Enter a note to the filer asking for more information in the Add Note 
region. This note will be automatically sent to the filer in an e-mail.

d. Click Update.

6. Use the links at the top of the window to enter optional related information:

� Contacts. If you know other individuals who should be kept up to date 
about this defect, then click Contacts and follow the instructions in 
Changing Who Gets Notified.

� Related Documents. If there are any related defects, service requests, or 
other documents, then click the Related Documents link to enter them.

� Tasks. If there are any tasks you need to assign to others, then click the 
Tasks link to enter them. The tasks you create appear on the Universal Work 
Queues of the individuals you assign them to. You need no special 
permission to assign a task to another person in the organization.

� Attached Files. If you like to attach files or URLs to the defect, then click 
the Attached Files link to make your entry.

7.  If you need to ask informal follow-up questions, then in the Log region, click 
on the name link for the person who filed the defect to create an e-mail, or, if 
you cannot progress further without a response, then create a task.

8. If the Product is incorrect, clear the old product from the Product field, and 
follow the instructions in Using the List of Values.

9. If you are satisfied that the defect or enhancement request is valid, then:

a. Set the phase of the defect to Resolve.

b. Set the Defect Status to Awaiting Resolution.

c. Click Update.

After you change the Phase to Resolve and click Update, your defect is 
automatically assigned to an available engineer. You are notified by e-mail each 
time the defect is updated or if the responder requires any more information to 
proceed.
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Resolving a Defect or Enhancement Request
Resolving a Defect or Enhancement Request
Use this procedure to record actions you have taken to fix defects or implement 
enhancements. 

You can resolve a defect or enhancement only if you are the person assigned to 
resolve defects in the Resolve phase.

To resolve a defect enhancement request:
1. Navigate to the Defect Detail window. See Viewing Defects Assigned to You.

2. If for some reason you are not the right person to fix this defect, then you can 
reassign the defect to others following the procedure outlined in Reassigning a 
Defect to Others.

3. Use the links at the top of the window to assign tasks to others in your team 
and to enter optional related information:

� Related Documents. If there are any related defects, service requests, or 
other documents, then click the Related Documents link to enter them.

� Tasks. If there are any tasks you need to assign to others, then click the 
Tasks link to enter them. The tasks you create appear on the Universal Work 
Queues of the individuals you assign them to. You need no special 
permission to assign a task to another person in the organization.

4. If you need more details from the individual handling the Respond phase, then:

a. Revert the phase of the defect back to Respond.

b. Set the Defect Status to Awaiting Response.

c. Enter a note to the filer asking for more information in the Add Note 
region. This note will be automatically sent to the filer in an e-mail.

d. Click Update.

5.  If you need to ask informal follow-up questions, then in the Log region, click 
on the name link for the person who filed the defect to create an e-mail, or, if 
you cannot progress further without a response, then create a task.

  

Note: Any e-mail you send does not become a part of the defect 
record unless you attach it as a document or paste it in as a note.
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Verifying a Defect or Enhancement
6. After you have fixed the defect or implemented the enhancement, then:

a. Enter the version you have fixed or the future version in which the 
enhancement will be implemented in the Fixed Version field.

b. If you wish to contribute this fix or enhancement to the Knowledge Base, 
then check the Contribute to Knowledge Base check box.

The Knowledge Base makes an edited version of the defect record available 
to others in your company and to your customers.

c. If the fix or enhancement resulted in a functional change, then check the 
Functional Change check box. This alerts quality assurance and 
documentation.

d. If the fix or enhancement resulted in a user interface change, then check the 
Interface Change check box. This alerts quality assurance and 
documentation.

e. If you wish to record which files were changed, the click the Modified Code 
link at the top of the window and enter the file names.

f. In the Phase region, change the Phase to Verify.

g. Click Update.

After you change the Phase to Verify and click Update, your defect is 
automatically assigned to an available quality assurance engineer or to their 
team. You will be notified by e-mail each time the defect is updated or if the 
responder requires any more information to proceed.

Verifying a Defect or Enhancement 
Use this procedure to verify that an existing defect or enhancement has been 
processed in accordance with the set of procedures and business rules.

To be able to verify a defect or enhancement, you must be the person assigned to 
resolve defects in the Verify phase.

To verify a defect:
1. Navigate to the Defect Detail window. See Viewing Defects Assigned to You.

2. If for some reason you are not the right person to verify this fix or enhancement, 
then you can reassign the defect to others following the procedure outlined in 
Reassigning a Defect to Others.
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Verifying a Defect or Enhancement
3. If the fix or enhancement does not meet quality standards, you can send back 
the defect or enhancement request to the person who was originally assigned to 
work on it:

a. Revert the phase of the defect back to Resolve.

b. Set the Defect Status to Awaiting Resolution.

c. In the Add Note region, enter a note to the filer explaining why you rejected 
the fix or enhancement. This note is automatically sent to the person who 
owned the Resolve phase in an e-mail.

d. Click Update.

The defect is automatically reassigned to the person who owned it in the 
Resolve phase. That individual is notified automatically by e-mail and a 
message in the Universal Work Queue.

4. If you need to ask informal follow-up questions, then in the Log region, click on 
the name link for the person who filed the defect to create an e-mail, or, if you 
cannot progress further without a response, then create a task.

  

5. If there are any tasks you need to assign to others, then click the Tasks link at 
the top of the window to enter them. The tasks you create appear on the 
Universal Work Queues of the individuals you assign them to. You need no 
special permission to assign a task to another person in the organization

6. After you have verified that the defect or enhancement meets quality standards, 
then:

a. Enter the name of the test you performed to verify the fix or enhancement.

b. From the Test Type drop-down list select the type of test you performed.

c. If you wish to attach your test plan then click the Attached Files link at the 
top of the window to attach it.

d. If there are no documentation fixes to make, then in the Phase region, 
change the Status to Close.

e. Click Update.

Note: Any e-mail you send does not become a part of the defect 
record unless you attach it as a document or paste it in as a note.
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Managing a Defect in the Documentation Phase
7. If documentation changes are required, then in the Phase region:

a. Set the Phase to Documentation.

b. Set the Defect Status to Awaiting Response.

c. Enter an optional note to documentation about what changes need to be 
made. This note will be automatically sent to the filer in an e-mail.

d. Click Update.

The defect or enhancement is automatically assigned to the writer in 
charge. The writer receives an e-mail notification and a task on their 
Universal Work Queue. 

Managing a Defect in the Documentation Phase

To record changes you make to a defect in the documentation phase:
1. Navigate to the Defect Detail window. See Viewing Defects Assigned to You.

2. If for some reason you are not the right person to document this fix or 
enhancement, then you can reassign the defect to others following the 
procedure outlined in Reassigning a Defect to Others.

3. If you need a clarification from any person in the organization, then: 

a. Reassign the bug to the individual following the procedure outlined in 
Reassigning a Defect to Others.

b. In the Log region, enter your query.

c. Change the Status to Awaiting Response.

d. Click Update

4.  If you need to ask informal follow-up questions, then in the Log region, click 
on the name link for the person who filed the defect to send an e-mail.

  

5. After you have completed fixing the documentation, then, in the Phase region, 
change the Status of the defect to Closed.

Note: Any e-mail you send does not become a part of the defect 
record unless you attach it as a document or paste it in as a note.
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Assigning a Task Relating to a Defect or Enhancement
Viewing Defect History

To view the history of a defect
1. Navigate to the Defect Detail window.

2. To view the notes entered for this defect, scroll down to the Log region where 
all the notes are displayed.

3. To view the history of the changes in other fields, click on the Audit History 
link.

Assigning a Task Relating to a Defect or Enhancement
Use this procedure to assign a task to another person while editing a defect. The 
task you create appears in that person’s Universal Work Queue.

To be able to assign tasks related to a defect or enhancement, you must be creating 
an editing a defect or enhancement.

To assign a task to another person while editing a defect:
1. Navigate to the Defect Detail window.

2. Click the Task link at the top of the window. The Tasks window appears.

3. Click Create Task.

The Create Tasks window appears.

4. In the Name field, enter a summary title.

5. Select a priority from the Priority drop-down list.

6. In the Owner field, use the list of values (LOV) to enter the person who is 
getting assigned to this task.

7. If appropriate, enter any information about the duration of the task and 
deadlines in the fields provided. 

8. Click Create.
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